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How to Use the Online Manual

This Online Manual provides instruction for the operation of your new unit. Please read the following explanation of how
to use the Online Manual, and then search for the information that you need.
For more information about computers, operating systems and Acrobat Reader, please refer to the relevant manual or

help file.

How to Control the Online Manual

. . . Takes you back page by page. To return to the previous link,
Click this button to display the Table of l click the (ﬂ) button on the menu bar of the Acrobat Reader.

Contents of the Online Manual. From the Table
of Contents you can jump to various pages.

Click this button to display the Index of the CONTENTS Tak ; d b
Online Manual. From the Index you can akes you forward page Dy page.

jump to various pages.

Following links

Links can connect parts of a document to other parts for further information. In this document, green colored letters are linked areas.

To follow a link, select a hand tool (¥™), a zoom tool or a selection tool. Position the pointer over the linked area on the page until the pointer
changes to a hand with a pointing finger (). Then click the link.

Using Bookmarks

This online manual has Bookmarks on the main pages of each section. You can move to the desired pages by simply clicking its bookmark.

How to Print Out the Online Manual
In order to print out a hard copy of the Online Manual for your reference, go to Acrobat Reader, click the "File" menu, and

select "Print". After specifying the printer setting, click the "OK" button to print.

® In this online manual, screen images and operating procedures are mainly for Windows XP. With other versions
of Windows, some screen images may be different from those in this manual.

® \Wherever "AL-xxxx" appears in this manual, please substitute your model name for "xxxx".

® The SPF that is mentioned is only for AL-2040.
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Printing Overview

The flow chart shown below provides printing overview.
Reference: For more information on printing, see Basic Printing.

over a network connection is not possible.

® \When the paper source is the paper tray or multi-bypass tray, verify that the paper has been loaded before starting
printing.

® Ensure printing has been completed before turning the power off. Do not remove the power cord before turning
the unit off.

@ ® The printer function is only available when the machine is connected to your computer using a USB cable. Printing

Caution

Prepare the document you intend to print

Open the printer driver setup screen and set the print preferences
Reference:

Printer Driver Settings, Printing a Watermark, Fitting the Printed Im he Paper,

Printing Multiple Pages on One Page, Two-sided Printing

Send print data from your computer

Printing

Exit printing I

CONTENTS 4
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Basic Printing

This is a printing example using WordPad to print a document onto A4 size paper.

Start WordPad, make a new file, and enter the text Click the "Print" button in the "Print" dialog box.
you intend to print. On Windows 98/Me, click the "OK" button.

.General-|

Select "Print" from the application's "File" menu.

Select Printer

= @
ZW Edit View Insert For B 2
RTINS Chrl+M #dd Prinker SHARP

ALK
Qpen... Chrl4+0

Sawe Chrl+3 Status:  Ready [ Print ta file

Save As... Location:

Comment: Find Printer...

Prink Prewiew [! Fage Range

[OF] Mumber of copies: i 1

Make sure that "SHARP AL-xxxx" is selected as the — @l
Current prlnter. If yOU Intend tO Change a.ny prlnt Entereitherasinglepagenumberorasinglé

page range. For example, 512

setting, click the "Preferences" button to open the
printer driver setup screen. o N [owes |
On Windows 98/Me, click the "Properties” button.

Printing starts according to your preferences.

Identify the current printer
in this box.

General

Select Printer

_
= any print preference.

Reference: Printer Driver Settings, Printing a Watermark, Fitting the
Printed Image to the Paper, Printing Multiple Pages on
One Page, Two-sided Printing

3 Windows 2000 does not have the "Preferences CONTENTS <

button on this dialog box. Switch to the desired

tab by clicking it to specify printer settings. INDEX




Starting the Printer Driver Using the "Start" Button

You can open the printer driver and change the printer driver settings from the Windows "start" button. Settings adjusted
in this way will be the initial settings when you print from an application. (If you change the settings from the printer
driver setup screen at the time of printing, the settings will revert to the initial settings when you quit the application.)

Reference: Basic Printing
Windows 2000/XP/Vista Windows 98/Me

Click the "start" button, and then click "Control Click the "Start" button, select "Settings" and then

Panel". click "Printers".

On Windows 2000, click the "Start" button and select

"Settings™. Click the "SHARP AL-xxxx" printer driver icon and
select "Properties” from the "File" menu.

Click "Printers and Other Hardware", and then click s oL

"Printers and Faxes". Delete

* On Windows Vista, click "Printer". Rename

« On Windows XP, click "Printers". | Properties y |

A%

Close

Click the "SHARP AL-xxxx" printer driver icon and
select "Properties” from the "File" menu.

. Click the "Setup" tab.
Set Up Faxing

Creabe Shortout General | Detailsl Sharingl Setup
Delete

Rename The printer driver setup screen will appear.

M Reference: Printer Driver Settings

Close

On Windows Vista, click "Printer".

Click the "Printing Preferences" button in the
"General" tab.
The printer driver setup screen will appear.

Reference: Printer Driver Settings CONTENTS {
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Printer Driver Settings

To view Help for a setting, click the (g) button in the upper right-hand corner of the window and then click the setting.

Tab
Index which allows you to
switch between the various
setup screens.

& Main IF'aper | Advanced i atermarks |

(i) button
Click this button and then click a

Frequently used setting

Check box
Click this option to activate/
deactivate each function.

The settings you made at
"N-Up Printing", "Document
Style", "Fit To Paper Size",
"Image Orientation" and
"Watermark" are shown in
this image.

PR S i .

|Jzer Settings

|

setting to view Help for the setting.

4 You can also view Help by
right-clicking the setting

| Untitled

Note wijth the mouse.

[

Document Style

Check button
Allows you to select one
item from a list of options.

The tray selected in
"Paper Selection" in the
"Paper" tab appears in
blue. You can also click
on a tray to select it.

-Sided
(_E-Sided [Baook]
-Sided [T ablet]

Drop-down list
Allows you to make one
selection from a list of choices.

"Apply" button
Click to save your settings
without closing the dialog box.

= The "Apply" button does
not appear when you
Note open this window from

.7

an application.

Apply M

J

"OK" button
Click this button to save
your settings, and exit the
dialog box.

"Cancel" button

l Ok I[ Cancel ]I[

Click this button to exit the dialog
box without making any changes to

the settings.

L "Help" button

The Help window will open to
let you view explanations of the

settings on the tab.

CONTENTS
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Printing a Watermark

To print a watermark, for example "CONFIDENTIAL", on your document, refer to the following steps. Open the printer
driver and click the "Watermarks" tab.
Reference: See Basic Printing for details on how to open the printer driver.

How to Print a Watermark
From the "Watermark" drop-down list, select the watermark, for example "CONFIDENTIAL", you wish to print on your
document, and start printing.

W atermark:

| (None) ﬂ W atermark:
[Mane) S I _ ;
TOFP SECRET — COMFIDEMT LA

DRAFT -
ORIGINAL .

Print sample

For details on watermark settings, view printer driver Help.
Reference: Printer Driver Settings

CONTENTS <
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Fitting the Printed Image to the Paper

This printer driver can adjust the zoom ratio for printing according to the paper loaded in the unit.
Follow the steps shown below to use this function. The instruction below assumes that you intend to print an A4 size
document onto an A5 size paper.

[L:;: The "Fit To Paper Size" setting is not available when "N-Up Printing" is selected.
Reference: Printing Multiple Pages on One Page

Note

Click the "Paper" tab in the printer driver setup Select the paper size for "Fit To Paper Size", which
screen. corresponds to the size of paper in the unit.

Now, the printed image will automatically fit the paper
Select the paper size for the print data from "Paper set in the unit.

Size". Paper Size: A4

Fit To Paper Size: A5

Check the "Fit To Page" box.

Fit To Paper Size
Fit to Page

Print &4 on

_ A5 size paper
A5 A4 size document (Fit To Paper Size)

(Paper Size)

CONTENTS <

INDEX




Printing Multiple Pages on One Page

This feature allows you to print two or four document pages onto a single page.
To use this function, open the printer driver setup screen, select "2-Up" or "4-Up" for "N-Up Printing" on the "Main" tab.

ﬁ- The "N-Up Printing" setting is not available when "Fit To Paper Size" is selected.
Reference: Fitting the Printed Image to the Paper

T M Border Border
MN-p Printing

v -
[ ] Border A C D D

e Rl

i CD

If you select the "Border" checkbox, border lines will be printed on each page.

CONTENTS 4
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Two-sided Printing

You can print on both sides of the paper.

To use this function, open the printer driver setup screen and select “2-
Sided (Book)" or "2-Sided (Tablet)" from "Document Style" in the "Main"
tab.

Drocurment Shple
() 1-5ided

{E} 2-5ided [Boak]
() 2-5ided [T ablet]

ﬁ. The multi-bypass tray can not be used for two-sided printing.
Note

The following example shows the result when portrait data is printed on both sides of the paper.

Printing result

Print data
2-Sided (Book) 2-Sided (Tablet)

Xy
1
I
g
i
i
i
i
i
- il
(Y s
e 1y
R ¥ 1|
-‘, i
e o
ol 1
=
1
1
(%

The pages are printed so The pages are printed so that
that they can be bound at they can be bound at the top.
the side.

CONTENTS 4
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Outline of the Print Status Window

When printing begins, the Print Status Window activates and appears on the screen.
The Print Status Window is a program designed to show the current printer status including the document name being

printed and error messages.

Status icon

This icon informs you of the print status.

Tab

=sire

CEX

Status window
Provides details on the current
status of the print job.

I Fririt b anitor ]Dpliuns ]

Diocurnent M arme:

Index which allows you to switch
between the two setup screens.

"Close" button

Document Name

Displays the name of the active print
job.

— "Cancel Job" button

Printing can be canceled by clicking
this button before the machine
receives the job.

' Cancel Job ?

Click this button to close the Print
Status Window.

— "Help" button
Click this button to display help file

Cloze i'

Help h for the Print Status Window.

CONTENTS <
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Scanning Overview

The flow chart shown below provides scanning overview.

The scanning feature can only be used with computers that are connected to the machine by a USB cable. If you
Cattion are connected to the machine by a LAN connection, only the printer function can be used.

When scanning from TWAIN*!-compliant When scanning from "Scanner and : h : : 0 %3
or WIA*2-compliant application :. Camera Wizard" (Windows XP/Vista :: Using the unit to begin scanning
] ]

ll
Place the original in the scanning position
Reference: For more detail, refer to the "ORIGINAL PLACEMENT" in the Operation Manual.

Change the unit to scanner mode
and select scan menu (SC1 to SC6)
on the operation panel.

Start up the "Scanner and Camera
Wizard" from "Control Panel" in
your computer.

Start up a Twain-compliant or WIA-
compliant application, and select
the unit's scanner driver.

Scanning

Scanning[’] Scanning
Reference: Scanning an Image from a Reference: Scanning an Image from the Reference: "USING THE SCANNER
lication, "Scanner and Camera MODE" in the Operation

TWAIN-Compliant A
Scanning an Image from a Wizard" (Windows XP/Vista) Manual,
line of Button Manager

WIA-Compliant Application
(Windows XP/Vista)

*1: TWAIN is an industry standard for interface of image data processing devices including scanners. By installing a TWAIN driver onto your computer,

you can scan and work with images using a variety of TWAIN-compliant applications.
*2:WIA (Windows Imaging Acquisition) is a Windows function that allows a scanner, digital camera or other imaging device to communicate with an

image processing application. The WIA driver for this unit can only be used in Windows XP/Vista.

*3:To scan using the unit's operation panel, you must first install Button Manager and establish the
CONTENTS 4 1 }

appropriate settings in the Control Panel. For details, see "USING THE SCANNER MODE" in

the Operation Manual.
INDEX

Note that not all scanner functions are available using Button Manager.




Scanning an Image from a TWAIN-Compliant Application (part 1)

The SHARP scanner driver conforms to TWAIN, the industry standard, making it compatible with a variety of TWAIN-
compliant applications. Below is a step-by-step guide for acquiring a scanned image to the Sharpdesk desktop screen
using Sharpdesk.

Place the original (s) you wish to scan on the Select "SHARP MFP TWAIN P", and click the
document glass/SPF. "Select” button.

Reference: For information on setting an original for scanning, refer
to "ORIGINAL PLACEMENT" in the Operation Manual.

Select Source

Sources:
SHARP MFP ThwialN P

After starting Sharpdesk, click the "File" menu and
select "Select Scanner”.

%< Sharpdesk
Eclit View Tools Internet Help ® |f you are using Windows XP/Vista, you can also
New Folder Clrl+h ; select "WIA-SHARP AL-xxxx" to scan using the
WIA driver.
Reference: Scanning an Image from a WIA-
Compliant Application (Windows XP/

Acquire Image... V—)-ISta

W ® Depending on your system, "SHARP MFP
From Scanner or Cattera... TWAIN P 1.0 (32-32)" and "WIA-SHARP AL-Xxxx
1.0 (32-32)" may appear in the "Select Source"
screen.

® The method for accessing the "Select Scanner"
option, depends upon the application. For more

information, refer to the manual or the help file
of your application.

CONTENTS <
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Scanning an Image from a TWAIN-Compliant Application (part 2)

Select "Acquire Image" from the "File" menu, or
click the "Acquire" button (1.2.)).

The scanner driver setup screen will appear.
Reference: Scanner Driver Settings

In the "Scanning Position" menu, select the
position in which you placed the original in Step 1
("Platen" (document glass) or "SPF").

Select "SPF" when you placed the original in the SPF.

Scapning Posilion
[Platen

Scsnning Mods
[Preset

Presets for Image Type and Fiesolution

Click the "Preview" button.
The preview image will appear.

@ If the rotation or angle of the image is different, reset
the original, and click the "Preview" button again.

® |f you set multiple pages on the SPF, the unit
previews only the page placed on the top of the
originals, and then sends it to the original exit
area. Return the previewed page to the SPF
before starting the scanning job.

Specify the scanning area, and set the scan
preferences.

For information on specifying the scan area and setting
the scan preferences, see scanner driver Help.

Reference: Scanner Driver Settings

O

Caution

Setting a large area with full color together with a
high resolution setting, makes the data size large,
resulting in extended scanning times. It is
recommended to set the scanning preferences
depending on the type of the original to be
scanned, i.e., Web Pages (monitor), Photo, FAX,
or OCR.

Click the "Scan" button after setting your preferences.

To cancel your scanning job after clicking the "Scan"
button, press the [Esc] key on your keyboard.

=% Sharpdesk
File Edit Wiew Tools Internet Help

=t &
Acquire Copy Composer Imaging

= @ Sharpdesk Desktop
103) Articles
Bills
{) Expense Reports
@ Important Documents
{C5) Receipts
{C5) Statements
() My Documents
+ :-) My Computer

Arrange Explorer

Convert By
OCR

When you close the scanner driver after scannThg, the
image data will appear as a new file in Sharpdesk.

<4

CONTENTS
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Scanning an Image from a TWAIN-Compliant Application (part 3)

Scanner Driver Settings
The scanner driver setup screen consists of the "Set-up screen”, which lets you select scan settings, and the "Preview
screen", which shows the scanned image. For details on the scan settings, click the "Help" button to display Help.

Set-up screen

"Scanning Position" menu E Scanning Position "Scanning Mode" menu

Select the desired scanning position from | Platen | Switch the scanning mode between the
"Platen" (document glass) or "SPF". "Preset" and "Custom Settings" screen.
Scarning Made : ® For details on each of these settings, click

.| Select "SPF" when you placed the Presel - the "Helo" button to display Hel
o original in the SPF. Pre M © “help”bution fo dispiay Help.

Presets for Image Type and Fezolution:
'wieb Pages Phata "Preview" button
Previews the document.

If "Preview" is canceled by

immediately pressing the [Esc] key

el on your keyboard or the clear key

“Scan" button C on the unit, there may be no

Click to scan an original or image according images displayed on the preview

to your preferences. Before clicking the b screen.

"Scan" button, check if your preferences are 15 asch

set correctly. B pccoEren

| To cancel your scanning job after "Zoom Preview" check box

7| clicking the "Scan" button, press the Image Area: If the [Zoom Preview] checkbox is selected

Note [Esc] key on your keyboard or the | Custorn before the [Preview] button is clicked, the
clear key on the unit. ) selected area will be enlarged in the preview

: 5 window.

|
Note

. Scan

CONTENTS < }
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Scanning an Image from a TWAIN-Compliant Application (part 4)

Preview screen

"Auto Scan Area Adjustment" button ——
Click when the preview screen is displayed to
automatically set the scanning area.

Click the "Auto Scan Area
~ 7 7 7 Adjustment" button to adjust
the scanning area
| automatically.

—
I

Entire preview screen

Preview window

Click the "Preview" button in the Set-up
screen to display the scanned image. You
can specify the scanning area by dragging
the mouse inside the window.

"Rotate" button

Each time this button is clicked, the preview
image rotates 90 degrees. This lets you
change the orientation of the image without
picking up and placing the original again. The
image file will be created using the
orientation that appears in the preview
window.

“Image Size" button
Click to open a dialog box that allows you to
specify the scanning area by entering

Fotate o— numbers. Pixels, mm, or inches can be
"Help" button mageSee (@) selected for the units of the numbers. By

Click to display the help file for the scanner Colr Mode - FullCole initially specifying a scanning area, numbers
driver. il s can be entered to change that area relative

Image Area : Custom

Size . 320MB to the top left corner as a fixed origin.

CONTENTS < }
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Scanning an Image from a WIA-Compliant Application (Windows XP/Vista) (part 1)

If you are using Windows XP/Vista, you can use the WIA driver to scan from Sharpdesk, Paint and other WIA-compliant
applications. The procedure for scanning using Paint is explained in the following.

If you have WIA drivers for other devices installed

Plare i eiigliel el iiish Lo sea @ e ﬁ- in your computer, the "Select Device" screen will

docum_ent gla_ss/SPF. : - : open. Select "SHARP AL-xxxx" and click the
Reference: For information on setting an original for scanning, refer "OK" button

to "ORIGINAL PLACEMENT" in the Operation Manual.

=% Select Device
After starting Paint, click the "File" menu and select Which device do you wantto use?
"From Scanner or Camera".

The scan screen of the WIA driver will appear. D)

DIGITAL
CAMERA

i§ untitled - Paint
W Edit  Miew Image Colors Help
W= Chrl+h

Cpen... Chrl+0 Manufacturer:  SHARF

Save Chrl+5 Description: SHARP AL-sxx
Save As..,

From Scannet or Camera. .. ] [ Caticel ]

Prink Presiew

Page Setup...
Print. .. Chrl+F

CONTENTS <
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Scanning an Image from a WIA-Compliant Application (Windows XP/Vista) (part 2)

Select the paper source and picture type, and click Click the "Scan" button.

the "Preview" button. Scanning begins and the image is acquired into Paint.
The preview image will appear. Use "Save" in your application to select a file name and
If you placed the original on the document glass, select folder for the scanned image, and save the image.

"Flatbed" for the "Paper source". P, L " "
If you placed the original in the SPF, select "Document -tl)—ﬁt(t:c?r? Cglligl? Eg:%gggg..’%ﬂt?gﬁ Flliekding e Tesen

Feeder" for the "Paper source" and specify the original
size in "Page size".

= Scan using SHARPI:I

What do you want to scan?

Faper source

Select an option below for the type of picture you
wank ba scan.

() Calor picture

() Grayzoale picture

Oﬁlack and white picture ar text
(O Custom Settings

You can also:

Adjust the guality of the scanned picture

[ Preview H Scan H Cancel ]

@ |f you select "Document Feeder" for the "Paper
= source" and click the "Preview" button, the

o original in the SPF is previewed. The previewed

Note original is sent to the original exit area and the
following original stops in the SPF. To eject the
original, press "C (clear)" key and return those
ejected originals to the SPF before starting the
scanning job.

® To view Help for a setting, click the ([gg) button
in the upper right-hand corner of the window

and then click the setting. CONTENTS <
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Scanning an Image from the “Scanner and Camera Wizard" (Windows XP/Vista) (part 1)

The procedure for scanning with the "Scanner and Camera Wizard" in Windows XP/Vista is explained here. The
"Scanner and Camera Wizard" lets you scan an image without using a WIA-compliant application.

Place the original you wish to scan on the Click the "Next" button.

document glass/SPF. .
Reference: For information on setting an original for scanning, refer T=Scepner.andLamera Miard
to "ORIGINAL PLACEMENT" in the Operation Manual. Welcome to the Scanner and Camera
Wizard

Click the "start" button, click "Control Panel", click
"Printers and Other Hardware", and then click SHARP AL-x00x
"Scanners and Cameras".

Thiz wizard helps vou copy pictures from your camera, scanner, or other
dewice to your computer, your network, or the Web.

Click the "SHARP AL-xxxx" icon and then click " Get
pictures" in "Imaging Tasks".
The "Scanner and Camera Wizard" will appear.

% Scanners and Cameras

File Edit ‘Wew Favorites Tools  Help

To continue, click MNest.

| Imaging Tasks | b Back | Mest» |\| [ Cancel ]

{8 Getpictures

Vieh_device properties

Other Places

U‘ Control Panel

D My Docurment s

| Shared Documents

CONTENTS <
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Scanning an Image from the “Scanner and Camera Wizard" (Windows XP/Vista) (part 2)

Select the "Picture type" and "Paper source", and E Specify a group name, format and folder for saving
click the "Next" button. the image, and then click the "Next" button.

If you placed the original on the document glass, select JPG, BMP, TIF or PNG can be selected for the format.
"Flatbed" for the "Paper source". To begin scanning, click the "Next" button.

If you placed the original in the SPF, select "Document
Feeder" for the "Paper source" and specify the original et o ot Dot

Size in "Page Size". Select a name and destination for your pictures.
You can click the "Preview" button to display the .
preview image. Ficud

=~ Scanner, and Camera Wizand

2. Select afile format:
= Scanner and Camera Wizard

| [£) JPG UPEG Image) v

Choose Scanning Preferences 5=
003€ Your scanhing preferences, and then click Preview to see how pour preferences affect 3. Choose a place to save this group of pictures:
Il

|B My Pictures\Ficture V| [ Browse...

() Black and white picture of text

() Custom
Custom zettings

Paper source:
Flatbed

[ < Back “ HEHM[\J[ Cancel ]

® |f you select "Document Feeder" for the "Paper
source" and click the "Preview" button, the top
original in the SPF is previewed. The previewed
original is sent to the original exit area, so you
will need to return it to the SPF before starting
the scanning job.

® To adjust the resolution, picture type, brightness
and contrast settings, click the "Custom

settings" button. CONTENTS <
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Scanning an Image from the "Scanner and Camera Wizard" (Windows XP/Vista) (part 3)

7 When scanning ends, the following screen will E Click the "Finish" button.
appear. Select the next task you wish to perform, The "Scanner and Camera Wizard" closes and the

and then click the "Next" button. scanned image is saved in the specified folder.
If you are ready to end the session, click "Nothing. I'm . r————
finished working with these pictures".

Completing the Scanner and Camera
=~ Scanner and Camera Wizard | Wizard

Dther Dptions

“Vou can choose to keep working with your pictures. 1 picture(s| were copied,

T 2 JOUT piCtLI your computer or netwark, click the location
our pi ey have bee eysfully copied to y ompuiter of netwark. M
Yau Ipblhth pl 23 o a'web i dnt\

what do you want to da?

() Publish these pictures to a'\web site
() Order prints of these pictures fiom a phota printing ‘web site
@i othing, ['m finished working with these pictures

Learn more about working with pictures.

To close thiz wizard and see your pictures, click Finish,

<Back || Finishb\\y}] [ Cancel

< Back H ﬂext)[\][ Cancel

CONTENTS <
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Outline of Button Manager

Button Manager is a utility software to link scanning functions to the SCAN key on the unit. This software enables you to
set scanning functions to six different scan menus, which will be linked to the SCAN key on the unit.

Reference: To begin scanning using the unit's operation panel, settings must be established in the Control Panel after the Button Manager is
installed. For information on installing the Button Manager, establishing the Control Panel settings, and scanning using the unit's
operation panel, see "USING THE SCANNER MODE" in the Operation Manual.

The functions of Button Manager are shown below.

Tab SeanMenu SC1 l ScanMenu SCZ] Scantenu SC3 | ScantMenu SC4 | ScanMenu 5C5 | ScanMenu SCB]
Click to set scan menu Appliation Selestion
OptlonS = Sharpdesk

"Application Selection" area
Select the start-up application
here.

Show TWAIN setting screen
"Scan Setup“ area l File Format | TIFF - When scanning
Set the scan Condltlons ll— Show TWaIN setting screen when scanning) You el SeleCt Whether or not the
. TWAIN screen is shown. When
I Some applications S EEL the checkbox is selected, the
may limit your choice Focbiode [rl ok TWAIN screen appears when
of seftings. Fioe [Nons scanning is executed to let you

Image Area |A4 . R .
h nnin nditions.
"OK" button s | G adjust the sca g conditions

Click to save your settings, Color Matching |For CRT
and exit the dialog box. |

1 7

Void Area

Lellef o] Le] Lo

"Help" button
“Cancel" button Click this button to display the
Click this button to exit the help file for Button Manager.

dialog box without making |_ "Apply" button

any chan h ) . .
se’%ings gestofne Click to save your settings without
i closing the dialog box.

Cancel |

You can specify and change your six scan menu options from five functions. Refer to Button Manager Settings to specify
and change the scan menu options.

unit.

Close the source application before using the SCAN key on the CONTENTS <
21
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Button Manager Settings

After being installed, Button Manager normally keeps active under the Windows operating system. Follow the steps

shown below to set scan options as you like.
For details on the settings in the setting screen of Button Manager, see Button Manager Help.

Right-click the Button Manager icon (&) on the task Set up the start-up application in the "Application
bar. Selection" area.

® \When the "Show TWAIN setting screen when
scanning"” checkbox is selected, the scan
setting screen appears when scanning is
executed to let you adjust the scanning
conditions.

® |f an application other than "Sharpdesk” is
selected in the "Application Selection” area,

only one original can normally be scanned. If

Select "Settings" from the displayed pop-up menu. vSharndesk® i acted fiole oriainal
: : arpdesk” is selected, multiple originals
The setting screen of Button Manager will open. loaded in the SPF can be scanned in a single

Reference: Outline of Button Manager operation,

If the Button Manager icon does not appear on the
task bar, click the "start" button, select "All
Programs" ("Programs" on Windows 98/Me/2000),
select "SHARP Button Manager P", and then click
"Button Manager" to start Button Manager.

Reference: Outline of Button Manager

Click the tab of the scan menu you want to set up.

Set up the "Color Mode", "Edge" and other scan

Scanhtenu 5C1 lScanMenu 5C2| ScanMenu SC3| ScanMenu S04 | ScanMenu SC5 | ScanMenu SCE | . . " N
settings in the "Scan Setup" area.

Reference: Outline of Button Manager

E Click the "OK" button.
You have completed the settings.
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ldentifying Unit Problems

When any trouble has occurred in the unit, first, verify whether you can make a copy or not with the unit. Check the
items shown below when the unit does not work properly but it can make a copy.

Reference: If any copier trouble occurs, refer to "TROUBLESHOOTING" in the Operation Manual.

What type of trouble do

Check the Connection between @ CPhecrlf \FflourEJC;m u:etrA e e USE < conn you have?
the Unit and Computer . : . * Printing trouble —— ®

* Scanning trouble —

Printing trouble Scanning trouble
When one of the troubles listed below occurs while When one of the troubles listed below occurs while

printing, check the corresponding item. scanning data, check the corresponding item.

Faint, Uneven or Smeared Print Output Poor Scanning Result

Characters or Graphics are not Printed in Correct Position The Scanned Image is Incorrectly Positioned
Nothing Prints Unable to Scan the Image

Uninstalling the Software Uninstalling the Software

=

Note

Make sure that the unit is not working. You cannot print from your computer or scan from the unit while the unit is
making copies.

O

Caution

The unit's scanning function can only be used if the unit is connected to your computer with a USB cable.

If you fail to solve the problem after verifying all the items listed above, please
contact your authorised SHARP service centre. CONTENTS {
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Check the Connection between the Unit and Computer

CHECK 1 Is the interface cable compatible with the
unit and computer?
Interface cables compatible with this unit are USB
and LAN cables. Check which type of cable is
supported by your computer, and then purchase
one of the following cables accordingly:
USB cable
Use a shielded cable.
LAN cable (AL-2040 only)
Use a shielded type cable.

® The AL-2020 does not have a LAN connector.
® The unit's scanning function can only be used if

caution  theunitis connected to your computer with a

USB cable.

CHECK 2 Is the interface cable connected securely?
Check if the interface cable is securely plugged into
the connectors of the unit and computer. It is also
advisable to ensure that the connector pins are not
bent.

Reference: See "CONNECTING THE INTERFACE
CABLE" in the Operation Manual for more
details on interface connection.

CHECHK 3 Are any other USB peripherals being
connected along with the unit?
If other USB peripherals are connected through the
same hub, disconnect them to see if the problem
still exists.

If the USB cable becomes disconnected

If the USB cable becomes disconnected, even only once during
the unit's operation, then printing and scanning may be
disrupted.

If this occurs, check the USB cable and ensure that it is
securely connected, then restart the computer.

When you are using a port created with Standard TCP/

IP Port

If you are using a port created using Standard TCP/IP Port in
Windows 2000/XP/Vista, printing may not take place correctly if
[SNMP Status Enabled] is selected in the port settings of the
printer driver. Open the printer driver properties and click the
[Configure Port] button on the [Ports] tab. In the window that
appears, make sure the [SNMP Status Enabled] checkbox is
not selected [].

CONTENTS
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Check Your Computer

Reference: Plug and Play Screen does not Appear (when the USB is connected)

CHECHK 1 Is there enough computer memory or hard CHECK 2 Is your hard disk fragmented?

disk space? When data is frequently stored/deleted, the hard
To use this unit, you must have an adequate disk may become fragmented causing a reduction
amount of hard disk space. If there is insufficient in printing or scanning speed. In this case it is
hard disk space, delete unnecessary files to recommended to defragment your hard disk. You
increase the free space of the hard disk. If there is may use the Windows tools or a commercially
insufficient memory, close unnecessary applications available hard disk defragmenting tool.

to increase memory available for printing or

scanning. If you are still unable to print or scan,

install more memory into your computer.

CONTENTS <
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Plug and Play Screen does not Appear (when the USB is connected)

If the Plug and Play screen does not appear after you connect the unit to your computer with a USB cable and turn on
the power of both devices, follow the steps below to verify that the USB port is available.

Click the "start" button, click "Control Panel", and
then click "Performance and Maintenance".

* On Windows Vista, click the "start" button, click
"Control Panel", and then click "System and
Maintenance".

* On Windows 98/Me/2000, click the "Start" button,
select "Settings"”, and then click "Control Panel".

Click "System", click the "Hardware" tab, and click
the "Device Manager" button.

"Universal Serial Bus controllers” will appear in the list
of devices.

CEX

£ Device Manager.

File  Action View Help

mE 2 A

% Computer

g Computer

+-g Disk drives

= g Display adapters

-, DYDCD-ROM drives

(= Floppy disk controllers

+ j Floppy disk drives

(= IDE ATASATAPT controllers

+-%za Keyboards

-7 Mice and ather pointing devices
§) Monitars

- B8 Metwork adapters
- 5 Ports (COM & LPT)
+ @,/ Sound, video and game controllers

+ System devices
+ Uriversal | Setial Bus con trollers

@ |f the "System" icon does not appear on
Windows Me, click "view all Control Panel
options" to view it.

® On Windows 98/Me, double-click the "System"icon
and click the "Device Manager" tab.

® On Windows 2000, double-click the "System"
icon, click the "Hardware" tab, and click the
"Device Manager" button.

® On Windows Vista, click the "System", and click
the "Device Manager" from the "Tasks".

Click the ([#]) icon beside the "Universal Serial Bus
controllers".

- E‘EIP Universal Serial Bus controllers
= Standard OpenHCD USE Host Controller
= |J5E Root Hub

Two items will display, your Controller chipset type and
Root Hub. If these items appear, you can use the USB
port. If the "Universal Serial Bus controllers” shows a
yellow exclamation point or does not appear, you must
check your computer manual for USB troubleshooting
or contact your computer manufacturer.

When you make sure that the USB port is enabled,
install the software, referring to "INSTALLING THE
SOFTWARE" in the Operation Manual.

<4
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Failed to Install the MFP Driver (Windows 2000/XP)

If the MFP driver cannot be installed under Windows 2000/XP, check your computer's settings according to the following
procedure.

Click the "start" button, and then click "Control
Panel".

On Windows 2000, click the "Start" button, select
"Settings", and then click "Control Panel".

Click "Performance and Maintenance", and then
click "System".
On Windows 2000, double-click the "System" icon.

Click the "Hardware" tab, and then click the "Driver
Signing" button.

The following dialog box will open.

Driver Signing Options

During hardware installation, Windows might detect software that
has not passed Windows Logo testing to werify its compatibility with
Windows, (Tell me why this testing is impaortant,)

wWhat action do vou wank Windows ko kake?

(") Ignore - Instal the software anyway and dan't ask Far my
appraowal

@ ‘Warn - Prompt me each time to choose an action

) Block - Mever install unsigned driver software

administrator option

Make this action the svstem default

[ ok

Check the "What action do you want Windows to
take?" ("File signature verification" on Windows
2000).

Wehat action do wou want windows to kaker?

(") Ignore - Install the software anyway and don't ask For my
approval

{E} W'arn - Prompt me each kime to choose an action

(") Black - Mever install unsigned driver software

If the option "Block™ has been selected for your
computer, then the MFP driver will not be installable.
Select the option "Warn" and then install the MFP driver
as explained in "INSTALLING THE SOFTWARE" in the
Operation Manual.

CONTENTS
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Faint, Uneven or Smeared Print Output

If print output is faint, uneven or smeared, follow the steps listed below.

CHECHK 1 Has the printer driver been specified to suit CHECK 4
both paper and the print job?
You can select "Draft", "Normal" or "Photo" for the
print quality in the "Advanced" tab of the printer
driver setup screen. When "Photo" is selected, you
can click the "Image Adjustment” button and adjust
the brightness and contrast in the dialog box that
appears. Adjust these settings appropriately for
your print data and try printing again.
Reference: Printer Driver Settings

CHECK 2 Is the paper curled?
If the paper is curled, straighten it up and set it in

the unit again. CHECK 5

CHECK 3 Is the paper too thick or too thin?
Only paper weighing from 56 to 80g/m? can be
used in the paper tray. Only paper weighing from 56
to 128g/m2 can be used in the multi-bypass tray.

Is it near time to replace the TD cartridge or
drum cartridge?
When it is near time to replace the TD cartridge or
drum cartridge, the TD cartridge replacement
required (..) indicator or drum cartridge
replacement required (<) indicator will light
steadily on the unit operation panel. When it is time
to replace either cartridge, the indicator will blink.
Replace the cartridge and try printing again.
Reference: See "TD CARTRIDGE REPLACEMENT",
"DRUM CARTRIDGE REPLACEMENT"
and "ABOUT SUPPLIES AND OPTIONS"
in the Operation Manual.

Did you set sufficient margins in the paper
settings of your application?

If the margins are set outside of the quality
guaranteed area, smudges or smears may appear
at the upper and lower edges of the paper.

When selecting the paper settings in the
application, set the margins from the top, bottom,
left and right edges of the paper to 4 mm.

CONTENTS {
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Characters or Graphics are not Printed in Correct Position

If a document is printed skewed or partly off the paper, follow the steps listed below.

CHECK 1 Is the paper size loaded in the tray the same CHECK 3 Is the paper loaded correctly?

as that specified in the printer driver?

Check if the "Paper Size" options suit the size of the
paper loaded in the tray.

If the "Fit To Page" setting is activated, make sure
that the paper size selected from the drop-down list
of the "Fit To Paper Size" option is the same as the
size of the loaded paper.

CHECK 2 Is the orientation of document setting

correct?

Click the "Paper" tab in the printer driver setup
screen, and verify if the "Image Orientation" option
IS set to your requirements.

If a document is physically damaged when it is
output or the image is skewed on the paper, discard
the damaged sheet, reinsert the paper supply and
print again. Insert the paper so that there is no
visible space between the paper and the paper
guides.
Reference: See "LOADING PAPER" in the Operation
Manual for more details on inserting paper.

CHECHK 4 Did you correctly specify the margins for the

application in use?

Check the layout of the document margins and the
paper size settings for the application you are
using. Also check if the print settings are specified
correctly to suit the paper size.

Reference: Faint, Uneven or Smeared Print Qutput
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Nothing Prints

If nothing prints even when the unit is turned on, please wait a few moments. The unit needs a longer time to process
intricate data. If the unit still does not print, refer to the check list below.

CHECK 1 Has a paper jam occurred?
When the misfeed (&) indicator blinks or (8 )
blinks in the display, the unit will stop because of a
misfeed.
Remove the jammed paper as explained in
"MISFEED REMOVAL" in the Operation Manual.

CHECK 2 Is the ON LINE indicator off?

The ON LINE indicator on the operation panel turns
off while the unit is used for copying. Scanning and
printing is not possible at this time. When copying is
finished, the ON LINE indicator will turn on after the
set auto clear time elapses, and the unit will be
ready for scanning and printing. You can also press
the clear key twice or press the ON LINE key to
make the unit ready for scanning or printing.

CHECHK 3 Is your unit selected correctly in the current
application for the print job?
When choosing "Print" from the "File" menu located in
applications, be sure you have selected "SHARP
AL-xxxx" printer displayed in the "Print" dialog box.

& Print
General
Select Printer

Add Printer

CHECK 4 Has the printer driver been installed

properly?
Check if the printer driver has been installed, following
the steps listed below.

1 Click the "start" button, click "Control Panel",
click "Printers and Other Hardware", and then
click "Printers and Faxes".

* On Windows Vista, click the "start" button, click
"Control Panel" and then click "Printer".

* On Windows 98/Me/2000, click the "Start" button,
select "Settings" and then click "Printers".

2 Check if the "SHARP AL-xxxx" printer driver
icon is shown.

.\‘ ] -
'-“‘ira SHARP AL-x00x

0
@ Ready

If you still cannot print after confirming the "SHARP
AL-xxxx" printer driver icon, the printer driver may not
have been installed correctly. In this case, delete the
software and then reinstall it.

Reference: Uninstalling the Software
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Poor Scanning Result

If you get poor quality as a result of scanning a job, and you cannot improve the quality by changing preferences, refer

to the check list shown below.

CHECK 1 Is the original clean?
Check your original before scanning. If any dust
sticks to the original, you cannot obtain a clean
result. In addition, make sure that the document
glass is also clean.

CHECK 2 Have you specified a suitable resolution?
Make sure that the value for the "Resolution" setting
in the scanner driver satisfies the requirement of the
set original.

Reference: Scanning an Image from a TWAIN-
Compliant Application,
Scanning an Image from a WIA-Compliant
Application (Windows XP/Vista),
Scanning an Image from the "Scanner and
Camera Wizard" (Windows XP/Vista).

CHECK 3 Have you specified a suitable value for the
"B/W Threshold" setting?
If you are scanning with a TWAIN-compliant
application and are using "Mono 2 gradation (no
Green)","Mono 2 gradation (no Red)" or "Mono 2
gradation (no Blue)" mode, make sure that a
suitable value is specified for the "B/W Threshold"
setting. A larger threshold value makes your output
darker, whilst a small threshold value makes it
lighter. To adjust the threshold automatically, click
the "Auto Threshold" button on the "Image" tab of
the "Custom Settings" screen.

Reference: Scanning an Image from a TWAIN-
Compliant Application

CHECK 4 Have you adjusted the brightness and

contrast suitably?

If you are scanning with a TWAIN-compliant
application and the resulting image has unsuitable
brightness or contrast (for example it is too bright),
activate the "Auto Brightness/Contrast Adjustment"
setting on the "Color" tab of the "Custom settings"
screen.

If you are scanning with a WIA-compliant
application or the "Scanner and Camera Wizard",
click "Adjust the quality of the scanned picture” or
the "Custom settings" button, and adjust the
brightness and contrast in the screen that appears.
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The Scanned Image is Incorrectly Positioned

If the scanned image is incorrectly positioned, refer to the check list shown below.

CHECK 1 Have you placed the original straight? CHECK 3 Have you set the original correctly on the
Place the original straight on the document glass. SPF?

Reference: Refer to "ORIGINAL PLACEMENT" in the To scan from the SPF, align the guide to the original
Operation Manual for the detail on how to as shown in the illustration below.
set the original.

‘ I

CHECK 2 Have you set the original correctly on the J
document glass?

Place the original on the document glass in the
direction as shown in the illustration below.

Align the center of the original with (») mark.

Align the guide to the original.

CONTENTS <
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Unable to Scan the Image

If you cannot scan the image, turn off your computer. Press the power switch on the unit to turn it off, unplug the unit from the power
source, and then plug it back in. Restart your computer. Try scanning again. If scanning is still not possible, refer to the check list below.

CHECK 1 1s your application compliant to TWAIN? CHECK 6 Are you trying to scan multiple originals in the
If you are using Windows 98/Me/2000 and your SPF at once?
application is not TWAIN compliant, the application When multiple originals are loaded in the SPF, it
cannot acquire images. Use an application that is depends on your application whether only one original
TWAIN compliant, such as the included Sharpdesk. can be scanned in a single operation, or whether

CHECK 2 Have you selected the scanner driver of this multiple originals can be scanned. Check whichis
unit on your application? possible in your application. (Sharpdesk allows multiple

Make sure that the "SHARP MEP TWAIN P" or "WIA- originals to be scanned in a single operation.)
SHARP AL-xxxx" is selected on your application. CHECK 7 Does your computer's operating system
Reference: Scanning an Image from a TWAIN- support the scanner driver?

Compliant Application The operating systems that support the unit's scanner

CHECK 3 Have you specified all scanning preferences driver are Windows 98/Me/2000/XP/Vista.

appropriately? CHECK & Are you using an appropriate interface?
Setting a large area with full color together with a high Make sure that the cable is connected securely to the

resolution setting, makes the data size large, resulting in LAN connector or the USB connector on your computer

extended scanning times. It is recommended to set the and the unit.

scanning preferences depending on the type of original  CHECK 9 Have the scanner driver and Button Manager

to be scanned, i.e., Web Pages (monitor), Photo, FAX, been installed properly?

or OCR. If normal scanning still cannot be performed even after
CHECK 4 Is there enough computer memory? confirming the items on the above check list, delete the

Your computer may not have enough available memory software and then reinstall it.

to hold the document you want to scan. Lower the scan Reference: Uninstalling the Software

resolution.

CHECK 5 Has the specified period of program timeout
already elapsed?
Neither printing nor scanning jobs can be sent to the
unit from your computer during the specified period of
program timeout after copying.
To send a scanning job immediately, press the clear key
twice, ONLINE key or SCAN key on the unit.
Reference: For more detail, refer to "USER

PROGRAMS" in the Operation Manual. CONTENTS {
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Uninstalling the Software

If printing or scanning is not possible, or Button Manager does not function correctly, check the items in "Nothing Prints" or
"Unable to Scan the Image". If you still cannot solve the problem, follow the steps below to uninstall the software (Printer driver,

Scanner driver, Button Manager), and then reinstall it.

@ Before uninstalling the software, close all applications.
Caution

Click the "start" button, and then click "Control
Panel".
* On Windows Vista click the "Uninstall a program”.
* On Windows 98/Me/2000, click the "Start" button,
select "Settings"”, and then click "Control Panel".

Click "Add or Remove Programs".

On Windows 98/Me/2000, double-click the "Add/
Remove Programs" icon.
The following dialog box will open.

ity installed pr ms:

Close.

Delete the "SHARP AL-xxxx Series MFP driver" and the "Sharp
Button Manager P" from the list of applications. For more
information, refer to your operating manual or to the help files
for your operating system.

Restart your computer.

The deletion of the driver and Button Manager is
completed when you restart your computer. If you wish to
reinstall, follow the instructions in "INSTALLING THE
SOFTWARE" in the Operation Manual.
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Printer Driver Features (part 1)

Setting Selections Initial setting
Copies 1to0 999 1
Collate On/Off On
N-Up Printing 1-Up/2-Up/4-Up 1-Up
Border On/Off Off
Document Style 1-Sided/2-Sided (Book)/2-Sided (Tablet) 1-Sided

User Settings - Factory Defaults

[User Settings]

Setting Name Up to seven names, 20 characters each

A3 [Fit To Page]*!, A4, A5, A6, B4 [Fit To Page]*!, B5, Ledger [Fit To
Paper Size Page]*!, Letter, Legal, Executive, Invoice, Foolscap, Folio, COM10, A4
Monarch, DL, C5, 8K [Fit To Page]*!, 16K, Custom Paper

Fit To Page On/Off Off
Image Orientation Portrait/Landscape/Rotate 180 degrees Portrait

Paper Source Tray 1, Bypass Tray Tray 1

[Custom]
Width 98.3 t0 215.9 (mm.) 98.3 (mm.)*?
Length 148.0 to 355.6 (mm.) 148.0 (mm.)*?

Size millimeters millimeters*2

(continued)
*1:Will be reduced to A4 size or the specified size before printing.
*2:This initial setting may vary depending on your operating system settings.
For information on each setting, see Help in the printer driver setup screen.
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Printer Driver Features (part 2)

Setting Selections Initial setting
Print Quality Draft/Normal/Photo Normal
2 Gradation Print On/Off Off
Advanced [Image Adjustment]
Brightness 0 to 100 50
Contrast 0 to 100 50
Watermark (None)/TOP SECRET/CONFIDENTIAL/DRAFT/ORIGINAL/COPY

Text -

Size 6 to 300
Angle -90 to +90
Gray Scale 0 to 255
On First Page Only On/Off

Watermarks
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About the Web Page

If the machine is used as a network printer, you can access the Web page in the machine using a Web browser. You can
check and change network settings in the Web page, and check the printer status.

I ® To access the Web page in the machine, the IP address must be assigned to the machine.
® For the Web browser, Internet Explorer 6.0 (or higher) or Netscape Navigator 7.0 (or higher) is recommended.
Note

Accessing the Web page

Use the following procedure to access the Web page.
When the connection is completed, the Web page will

Open the Web browser on your computer. appear in your Web browser.

- MENU - System Status

In the "Address" field of your Web browser, enter AL-XXXXCS [ Reload ]
the IP address of the machine as a URL. Printer Status TCRIP status

Enter the IP address previously configured in the SIS T itmens 132,168,110

. C Set Subnet Mask : 255.255.255.0
maChlne. H&u‘t Gateway addr: 192.165.1.1

Example: If the IP address is 192.168.1.43;

-3 about:blank - Microsoft Int

File Edit “iew Favaorites Tol

() Printer Status
Display printer status.

: . 2
o © [ 2 () System Status
Address | 192.168.1.43 Display system status.

() NIC Setup
Change network settings.

(® NIC Restart
To make new settings take effect, restart the network connection.

CONTENTS
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Configuration via the Web Page

To change network settings, click "NIC Setup”. The following screen will appear.

- MENU - [General] [Factory Default

AL-XXXXCS Name Value

Printer Status P Address 192.168.1.43
System Status Subnet Mask 5EF 955 955 )
NIC Setup Gateway 19216811
NIC Restart RARP DISABLE &
DHCP DISABLE v

Tassword

[NIC Setup]

After changing the network settings, click the "Submit" button to store the new settings. If you wish to cancel the new
settings, click the "Reset" button.

If a message appears prompting you to enter your user name and password, enter "admin"” for the user name,
ﬁ. "Sharp" for the password, and click the "OK" button.
The password can be changed in the above NIC Setup page. (Up to 7 characters can be entered.)
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